
Class-1 to 8Class-1 to 8(Teacher Manual)(Teacher Manual)

Think and ConnectThink and ConnectThink and Connect

1

THINK AND CONNECT  CLASS- 1

1. Computer- A Smart Machine

A. 1. F  2. T 3. F  4. T 5. T

B. 1. b 2. c 3. a 4. b 5. a

C. 1. bus, car 2. bicycle, rickshaw 3. car, bus 4. mixer, microwave 5. tree, chair

2. Computer and its Uses

A. 1. T, 2. T 3. T 4. F 5. F

B. 1. music 2. patients 3.calculations 4. draw 5. send, receive

C. 1. to listen to music and to play games. 2. to treat patients and to prepare bills. 3. 
to book tickets and to tell the arrival and departure time of aeroplanes and trains . 4. 
to teach students and to prepare report cards. 5. cooking, dancing and eating. 

3. Parts of the Computer

A. 1. F,2. T, 3. F,  4. T , 5. T

B. 1. different 2. keyboard 3. special 4. movies 5. CPU

C. 1. It looks like a typewriter. 2. CPU 3. It looks like a TV. 4. The mouse usually has 
two or three buttons. 5. CPU 

4. More about the Keyboard

A. 1. keys  2. alphabetic keys  3. 0,9  4. Function  5. two  6. two  7. Spacebar key

B. 1. b 2. d 3. c 4. b

C. 1. A keyboard looks like a typewriter which contains keys to feed information 
into the computer. 2. Keyboard is an input device. 3. There are 2 types of keys on a 
keyboard i.e., Alphanumeric (Letters & Numbers) and Special keys (function keys, 
control keys, arrow keys, caps lock key, and so on). 4. Spacebar key 5. 26 alphabetic 
keys 6. 10 number keys

function keys, control keys, arrow keys, caps lock key, and so on. 4. Spacebar key 5. 
26 alphabetic keys 6. 10 number keys

5. More about the Monitor

A. 1.monitor 2.screen 3.VDU 4.Visual Display Unit 5.output

B. 1. c 2. f 3. d 4. g 5. b 6. a 7. e

C. 1. b 2. b 3. c

D. 1. A monitor is an output device 2. A monitor is used to watch movies, write 
anything, feeding information, etc. 3. Three types 4. Output device 5. A monitor can 
be used to watch movies like in a television.

6. More about the Mouse

A. 1. pointer 2. mouse pad 3. two, three 4. monitor 5. input

B. 1.a 2.c 3.b 4.c
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C. 1. A mouse is an input device which is connected to the CPU. 2. A mouse is used 
to move the pointer, draw pictures, select any item and play games on the computer 
monitor. 3. two or three 4. Three types. 5. A mouse is an input device as it is used to 
move the pointer on the computer monitor.

7. Compact Disc

A. 1. video, text 2. 700 MB 3. Compact Disc 4. optical 5. DVD

B. 1. b 2. d 3. d 4. c
 ------------------------C. 1. A Compact Disc (CD) is small information in digital 

form. 2. We use a Compact Disc for recording, storing and playing audio, text and 
other information in digital form. 3. CD is capable of storing data upto 700 MB. 
4. Compact Disc 5. Digital Versatile Disc

D. 1. Compact Disc 2. Speakers 3. Keyboard 4. Mouse 5. Pen drive

8. Drawing in Paint

A. 1. paint 2. top 3. scanned 4. pencil 5. drawing

B. 1. b 2. b 3. b

C. 1. MS Paint program is a drawing tool used to create simple or elaborate 
drawings. 2. Print the drawings, view and edit the scanned photos, apply colours to 
the drawings, etc. 3.We can see the drawing area in the center of MS Paint window. 
4. Eraser tool is used to erase a part of drawing. 5. Pencil tool is used to make free 
hand drawings. 6. Eraser Tool, Pencil Tool, Color Tool and Brush Tool.

9. Storage Devices

A. 1. almirah 2. school bag 3. stored 4. lunchbox, school 5. refrigerator, vegetables

B. 1. c 2. d 3. b 4. d

C. 1. The area in which we can store our important things is a called storage. 2. We 
can use the stored data from the storage whenever we need it. 3. A Hard Disk Drive 

---------------- is planar magnetic surface.

THINK AND CONNECT CLASS- 2

1.Computer World

A. 1. F 2. T 3. F 4. T 5. F 

B. 1. students 2. library 3. music 4. skills 5. Doctors

C. 1. to teach students, to prepare fee bills and to keep details of books in library. 2. 
at home and in school. 3. cars, aeroplanes and other machines. 4. buildings and 
houses. 5. to maintain accounts of customers' deposit and withdraw money. 

2. Types of Computer

A. 1. T 2. F 3. T 4. T 5. F 
B. 1. shape, technology 2. Microcomputer 3. Desktop 4. keyboard 5. graphics

C. 1.a 2.d 3.b 4.c 5.a

---------------- D. 1. The computer sitting on as personal computers. 2. A laptop is a 
---------------- ---------------- personal acting as a mouse. 3. Desktop computers are 

---------------- types of personal computers. 4. A small computer literally means 
pocket computers. 5. With a stylus or digital pen on a touch screen. 



3. Parts of a Computer

A. 1. television 2. Processing 3. output 4. keys 5. Uninterrupted, Supply 6. CPU     
7. wire

B. 1. T 2. F 3. T 4. F 5. T 6. F 7. T 8. T

C. 1. d 2. b 3. c 4. d

D. 1. Monitor, CPU, Keyboard and UPS 2. A mouse is an animal which can run, eat, 
has a tail and lives in the hole while, computer mouse is a machine that can't run, eat 
and has a long tail like a mouse. 3. UPS keeps the computer running for several 
minutes even after the electricity goes off. 4. Function Keys, Scroll Key, Caps Lock 
Key, Alt key, Shift key, etc. 5. Speakers are used to play sound. They allow us to 
listen to music and hear sound effects from a computer.

E. 1. b 2. a 3. d 4. c

4. Input and Output Devices

A. 1. keyboard 2. scanner, computer 3. output 4. instrument 5. printout 6. CRT, LCD 

B. 1. F 2. T 3. T 4. T 5. T 6. F 

C. 1. d 2. b 3. b 4. b

D. 1. The device which shows us the information or result is called an output device. 
2. Monitor and Printer 3. Keyboard, Mouse, and Scanner 4. A scanner is an optical 
device that reads a printed page and converts it to a graphic image for the computer. 
5. A printer is used to get a printed copy of the information, make reports, projects, 
photos, greeting cards, etc. 6. CRT(Cathode Ray Tube) and LCD (Liquid Crystal 
Display) 7. A microphone is an instrument used to put sound into a computer. It 
needs a sound recording software.

5.  Keys of the Keyboard

A. 1. typewriter 2. window 3. Delete 4. Spacebar 5. cursor control 6. Tab 

B. 1. T 2. F 3. T 4. T 5. F 6. T 

C. 1. b 2. d 3. a 4. b

D. 1. Longest Key 2. Refreshes the current window 3. Open Windows Help 4. A 
document to the line below 5. A document one character to the right 6. Used to go to 
the next line 7. Erases the immediate character left of the cursor 8. Control Key 9. 
Used to move forward 10. Typewriter

E. 1. A keyboard looks like a typewriter which contains keys to feed information 
into the computer. 2. There are 4 types of keys on the keyboard. 3. Spacebar Key    
4. Without a keyboard, we cannot do most of the works on the computer. 5. The 
Shift Key has to be pressed every time(along with character key) we need to write 
character in capital letters while, the Caps Lock Key is pressed once if we need to 
write only in capital letters. 6. The arrow keys are control keys 7. The Tab Key is 
used to move forward through options in a dialog box. 8. The Enter Key is used to 
go to the next line or to get the result. 

6. Draw and Colour Shapes

A. 1. F 2. F 3. T 4. F 5. F 6. F

B. 1. a 2. c 3. b
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C. 1. Text tool 2. Color box 3. Polygon tool 4. Rounded Rectangle Tool 5. Air Brush 
Tool

7. Knowing Windows

A. 1. easier 2. program 3. selected 4. box, frame 5. internet 

B. 1. T 2. T 3. F 4. T 5. F 

C. 1. b 2. c 3. b 4. d

D. 1. The top of the screen 2. The bottom of the screen 3. Dustbin 4. Small pictures 
on the desktop 5. Close the title bar 6. Minimize the title bar 7. Maximize the title 
bar 8. Opens the selected icon

E. 1. When we switch on a computer, a screen is displayed called Windows 
Desktop. 2. The topmost bar of an application window. 3. Move the mouse pointer 
to the My Computer icon. Double-Click on the left mouse button. 4. Clicking the 
left mouse button 2 times. 5. When we click on any item on the screen, it gets 
selected. 6. It helps us to start the internet. 7. It is like a dustbin. We put waste files in 
it. It has an option to restore the files and folders removed by mistake. 8. An icon is a 
small picture that we see on the desktop. 9. Re-sizing a window: You can change the 
---------------- back to its normal size. 10. Windows 98, Windows 2000, Windows 
XP.

8. Calculator and Computer

A. 1. keyboard, mathematical symbols 2. single 3. numeric 4. information 5. many 
6. battery or cells.

B. 1. T 2. F 3. F 4. F 5. T 

C. 1. c 2. d 3. b

D. 1. Both computer and calculator have a keyboard and mathematical symbols. 
Both can generate results with high speed and accuracy. Both can process 
numeric information. 2. A computer can draw pictures which a calculator cannot. 
A computer can process non-numeric instructions which a calculator cannot. A 
computer has a large screen as compared to a calculator. 3. No 4. Numeric 
information 5. A computer can process numeric as well as non-numeric 
information.

9. Internet and Multimedia

A. 1. connection, computers 2. Multimedia 3. programs 4. boundaries 5. internet

B. 1. d 2. b 3. c 4. c

C. 1. Internet is a global network of millions of computers interconnected with each 
other. 2. Multimedia is the presentation of information through more than one 
presentation medium of the combination of text, sound, pictures, animation and 
video. 3. Entertainment, Education, Marketing and Advertising 4. We use internet 
to search anything and everything, for shopping, to keep in touch with our friends &  
relatives and to send the e-mails(electronic mails). 5. An e-mail is a electronic mail 
by which we can directly talk and chat with our friends and relatives.  

D. An internet is a global network connecting millions of computers. It is made up 
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of two words: inter means 'between' and net means 'connection'. When two or more 
computers are connected, it is called a network. Using an internet, we can share 
data, information, programs and messages as well.

E. We use different mediums to share any information with others. These mediums 
can be text, sound, pictures, animation, and video. Making use of these modes of 
communication is called Multimedia. 

10. Do's and Don'ts

A. 1. shoes 2. teacher 3. carefully 4. should not 5. clean

B. 1. F 2. F 3. T 4. T 5. F 6. T

C. 1. d 2. b 3. d 4. d

D. 1. We should not eat or drink. We should not wear shoes in the computer room. 
Keep the computer room clean and its door closed. 2. We should not press any 
power switch when the computer is ON. We should not press any key of the 
keyboard without knowing its function. Cover the computer after completing the 
work. 3. Do yourself 4. because the dust carried by shoes can be harmful for your 
computer system.

THINK AND CONNECT CLASS-3

1. Introduction to Computer

A. 1. T 2. T 3. F 4. T 5. F 

B. 1. IPO 2. billions 3. analog 4. binary 5. laptop

C. 1. c 2. a 3. c 4. d  5. b

--------------------- D. 1. Computer is an electronic machine maintain the accounts. 
------------------ ------------------- 2. Speed: all fields. 3. As its name itself groups of 

----------------- bits. 4. These are small version lot of heat. 5. These are very portable 
---------------- same type of task.

2. More about the Keyboard

A. 1. T 2. T 3. T 4. F 5. F 

B. 1. keyboard 2. numeric 3. Arrow 4. spacebar 5. home 
C. 1. c 2. b 3. d 4. a 5. b

------------------------- D. 1. There are (A to Z) 26 letter keys middle of the keyboard. 
----------------- 2. There are four arrows on the monitor. 3. When you type something 

---------------- ---------------- by the Caps Lock key. 4. It is used to marked with  (   ) 
---------------- sign.  5. The home key of a line.

3. More about Windows

A. 1. desktop 2. files 3. folder 4. Recycle Bin 5. screen saver

B. 1. b 2. d 3. a 4. c 5. a

------------------ C. 1. Windows is the most help of a mouse. 2. The desktop contains 
---------------- ---------------- are called icons. 3. A file is a collection similar files 

---------------- together. 4. Open Personalization then click OK. 5. Desktop 
--------------------- wallpaper permanently slideshow of images. 6. Right-click your 

---------------- on the desktop.
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4. Hardware and Software

A. 1. T 2. F 3. F 4. T 5. F

B. 1. software 2. joystick 3. output devices 4. software 5. system software 6. 
joystick

C. 1. d 2. b 3. c 4. d

D. 1. joystick 2. microphone 3. scanner 4. light pen 5. speakers 

E. 1. Keyboard 2. 85+90+69+98+76+84 3.Printer 4.Input and output devices 
5.Songs and movies

F. 1. Software is a set of instructions or program that tells the hardware what to do 
and how to do like– System software and Application software. 2. System software 
3. Part of the computer which we can touch and see is called hardware and the part 
of the computer which we cannot touch but see is called software. 4. Application 
software is a software which is used to do a specific type of work. 5. Program is a set 
of instructions given to the computer.

 5. Putting Data in a Computer

A. 1.small 2.keyboard 3.104, 110 4.optomechanical 5.QWERTY 6.0-9 7.Enter 
8.Shift 9.left 10.Spacebar

B. 1.c 2.b 3.d 4.c 5.b

D. 1. The mouse is an input device that is very small in size, used to give commands 
to the computer without writing the instructions on keyboard. It is used to 
select/deselect icons. 2. Spacebar Key 3. We use a scanner to input paper 

---------------- documents like TIFF, GIF or JPG format. 4. Mechanical Mouse: It 
---------------- has a rubber most commonly used with PC. 5. Keep the left button 

pressed and drag the mouse to move the object to the place where you want to place 
it. 6. (a) Ctrl Keys: They are used for issuing some special control instructions to 
the computer. (b) Esc Key: It is used to cancel or ignore the command that we have 
entered. 

6. MS Word 2013

A. 1. Word start screen 2. pops up 3. zoom control 4. document 5. keyboard 5. Redo

B. 1. a 2. c 3. d 4. b 5. d 6. a

---------------- ------------C. 1. Click the FILE and then click Open. 2. A template is a 
---- ---------------- starting a new project. 3. Editing means making tools to edit your 

---------------- text. 4. To select text using a mouse, text gets highlighted in grey. 5. If 
---------------- you wish to delete a character, Press Backspace. 6. The Cut and Paste 

---------------- commands the cursor is placed.

7. Tux Paint

A. 1. T 2. F 3. T 4. T 5. F

B. 1. c 2. b 3. b 4. a 5. b

C. 1. drawing, 2. 2002, 3. sub-section, 4. colours, 5. Magic

D. 1. Title Bar, Tools, Canvas, Brushes or Selector, Color Palette, and Help area 2. A 
dialog box will appear where you can choose from a solid background colour, or a 
starter image, on scrolling down. 3. Eraser Tool 4. The Magic tool gives you the 
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special effects to your drawing. 5. Quit

8. Internet and its Applications

A. 1. a 2. c 3. c 4. c

B. 1. everyday 2. e-mail, audio 3. collection, devices 4. Domain 5. File Transfer 
Protocol 6. World Wide Web 7. Chat 8. internet

C. 1. T 2. F 3. T 4. T 5. F 6. F 7. T

D. 1. logging on 2. username 3. Internet Explorer 4. web pages/websites 5. Home 
Page 6. navigate 7. e-mail

---------------- E. 1. Internet is a collection or mesh technologies. 2. Online 
shopping, Net banking, Communication, Job search, etc. 3. The requirements are 
Computer, Modem, Web browser, Telephone line and ISP. 4. Type 

---------------- www.google.co.in and at the top right corner click on Sign In option 
his or her email is created. 5. Trash consists of a list of mails deleted while Spam 
mails are unsolicited junk e-mails sent by commercial companies for advertising. 6. 
Online shopping, Net banking, Communication, Research, etc. 7. FTP is a standard 

---------------- network protocol images, multimedia files, etc. 

THINK AND CONNECT CLASS-4 

1. History of Computer

A. 1. F 2. F 3. F 4. T 5. T 6. F

B. 1. fingers, drawing 2. Abacus 3. Step Reckoner 4. Jacquard's loom 5. binary 6. 
ENIAC  
C. 1. b 2. d 3. a  4. c 5. a 6. c

 --------------------- D. 1. Early humans count fingers and toes.  2. Charles Babbage 
---------------- 3. Abacus was the first performed using the Abacus. 4. Napier's bones 

------------------- is a manually square root of a number. 5. Harvard Mark I computer 
----------------------- was mostly mechanical. 6. In 1671 the German mathematician 
---------------- addition and shifting.

2. History of Computer Generation

A. 1. F 2. T 3. T 4. F 5. T 6. F

B. 1. microcomputer 2. digital 3. storage 4. supercomputers 5. Analog 6. Hybrid  
C. 1. d 2. a 3. c 4. b 5. a 6. c 

---------------- D. 1. The computers manufactured to today's computers. 2. The third 
---------------- generation sharing and multiprograms also. 3. Computer devices 

---------------------- with Artificial Intelligence (AI) learn and organise themselves. 
---------------- 4. Most of the computers today than analog computers. 5. Hybrid 

---------------- computer are the medical and surgery. 

3. Input, Output and Storage Devices

A. 1. F 2. T 3. F 4. T 5. F 6. F 7. T 8. T 9. T 10. T

B. 1. peripherals 2. buttons 3. touch 4. barcode, thicknesses 5. kiosks, ATMs 6. 
VDU 7. Liquid Crystal Display 8. digital 9. Computer Aided Design 10. Cathode 
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Ray Tube.

C. 1. d 2. b 3. c 4. a 5. d

D. 1. j 2. i 3. f 4. a 5. g 6. h 7. d 8. c 9. b 10. e 

E. 1. The devices that send data to the computer are called input devices. 2. The 
devices that receives output from a computer are called output devices. 3. A 
keyboard is a text base input device and a mouse is a small device used to point to a 

---------------- particular place on the screen. 4. 2 or 3 types 5. Monitor : It is an 
(CRT) to display information. 6. Two types, Impact and Non-impact printers. 

4. Computer Software

A. 1. F 2. T 3. T 4. F 5. F 6. T 7. F 8. F 9. T 10 .T

B. 1. Hardware 2. physical 3. computer 4. System 5. master 6. programming 7. 
interpreter 8. Application 9. Database 10. Media Player 

C. 1. d 2. c 3. b 4. c

D. 1. g 2. f 3. a 4. b 5. h 6. c 7. e 8. d  

E. 1. Computer Software is a collection of computer programs. 2. Hardware is a 
physical part and Software is a logical part. 3. Three 4. It is a master control program 
that runs the computer by controlling all of its components and acts as a scheduler 
like– Unix, Linux and Windows XP 5. Operating System is a master control 
program that runs the computer while Programming Language is used in the 
communication of computer instructions. 6. Assembler is a language translator for 
a low level programming language while Interpreter translates and executes each 
program statement one at a time. 7. Application Software is a software, written in 
high level language, which is able to manipulate text, numbers and graphics. 8. 
Media Player is used for viewing movies and listening to music and songs. 

5. More on Windows 7

A. 1. Navigation 2. default 3. four 4. folders 5. original

B. 1. b 2. d 3. a 4. c 5. d

---------------- C. 1. The Libraries feature in library called Pictures. 2. Click New 
---------------- ---------------Library from menu then press Enter. 3. A network folder 

---- ------------------ (for example, Documents). 4. To rename a Organize > Rename. 
----------------------------- 5. Open the drive or and then click Paste. 6. To delete a file 

----------  Recycle Bin window. 

6. Desktop and Start Menu

A. 1. F 2. T 3. T 4. F 5. T 6. T

B. 1. colours, Active Window 2. desktop 3. right clicking 4. explore 5. date, hide    
6. restart, Shut down

C. 1. d 2. c 3. a 4. b
-------------------- D. 1. Right click on the mouse in a blank background will be 

-------------------- changed. 2. Right click the mouse items by Name. 3. Right click 
on an icon and then click on Rename option to rename the icon. 4. Right-click on the 

-------------------- -----------bottom desktop and click OK. 5. Right click the Taskbar 
--------- then click on OK.
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7. Formatting Text in Word 2013

A. 1. Formatting 2. default 3. character 4. text 5. box

B. 1. a 2. b 3. d 4. a 5. b
-------------------- C. 1. Formatting is the process look more attractive. 2. Select the 

-------------------- -------------------- text any available fonts. 3. In Word 2013, there 
-------------------- glow, reflection, etc. 4. Highlighting means making gets 

--------------------  highlighted. 5. Select the text or to the selected text.

8. Introduction to PowerPoint 2013
A. 1. presentation 2. Title bar 3. current 4. theme 5. template 6. presentation 7. slides 
8. pages
B. 1.a  2. c 3. b 4. a 5. d 6. a 7. a 8. c

-------------------- C. 1. Click Start > All Programs  presentation will appear. 2. The 
--------------------Quick Access Toolbar lets  Undo, and Redo. 3. It is displayed just 

------------------ ------------------- below groups of commands. 4. Click the FILE tab 
-------------------- presentation will appear. 5. Click the INSERT  currently selected 

-------------------- slide. 6. Click the file tab return to the presentation. 

9. LOGO Commands

A. 1. F 2. T 3. T 4. F 5. T 6. F 7. F 8. F 

B. 1. LOGO 2. Home 3. Hide turtle 4. PENDOWN 5. PENERASE 6. PRINT 7. 
PRINT

C. 1. c 2. b 3. b 4. a

D. 1. PenUp 2. PenErase 3. PenDown 4. Forward 5. Backward 6. Home 7. Hide 
Turtle 

E. 1. The commands used to draw continuous drawings with the help of triangle 
shaped turtle that moves on computer screen are called LOGO commands. 2. PU, 
PE, PD, Repeat 3. PD puts the turtle's pen back on the screen while PE command 
erases the lines drawn by the turtle's pen. 4. REPEAT command is used for doing the 

-------------------repetitive actions like to make a drawing. 5. REPEAT 360[FDRT1] 
more smaller circle. 6. PRINT MATHEMATICAL EXPRESSION [Enter key >], 
and then PRINT[TEXT EXPRESSION] [Enter Keys >]

10. More on Internet Searching

A. 1. T 2. T 3. F 4. F 5. F 

B. 1. superhighway 2. Millions 3. World Wide Web 4. Uniform Resource Locator 5. 
software programs 6. browser 7. search engine

C. 1. b 2. d 3. a 4. c

D. 1. Internet is the international network of millions of computers interconnected 
with each other to share the information. It is used for searching and data on any 
topic, chatting, instant messaging, video calling and conferencing, etc. 2. Very first 
web page that we see on opening a website is called a Home Page. 3.URL is a 

-------------------- formatted text string resources on the internet while a hyperlink 
-------------------- takes to other web pages. 4. A software program that allows us to 

search for and view various information on the web. Microsoft Internet Explorer, 
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Opera, Mozilla's Firefox and Mac Safari. 5. Click the Internet Explorer 
------ displayed on the browser. 

THINK AND CONNECT CLASS-5

1. The Versatile Computer

A. 1. T, 2. F 3. T, 4. F, 5. T, 6. T

B. 1. IPO, 2. programs, 3. microphones, 4. Hospital, 5. cheques 6. fights 

C. 1. c 2. a  3. d 4. a 5. b
----------------------------- D. 1. A computer is used at home making expense sheets. 

-------------------- 2. Computers are very useful and time tables. 3. Computers are 
-------------------- -------playing an cheques of customers. 4. Mouse: It is also called 

------------- -------------------- some do not. 5. A scanner is a device editing and 
-------------------- display. 6. As per the title, computers aid tools and softwares.

2. Data Storage Media

A. 1. T 2. T 3. T 4. F 5. T 6. F

B. 1. eight 2. Silicon 3. Primary 4. volatile 5. PROM 6. information 

C. 1. d 2. a 3. b 4. b 5. a 6. c 
-------------------- D. 1. A bit has a single multiples called bytes.  2. RAM  stands for 

--------------------- ---------------------- in it is lost. ROM stands for does not get lost. 
----------------------- --------3. This stands for can only be read. Electrically Erasable 

------------ -------------------- data of ROM. 4. It is another form retrieved very fast. It 
-------------------- is a pen-like device USB drive or a flash drive. 

E. a. 1024 bytes  b. 1024 KB  c. 1024 MB  d. 1024 GB  e. 1024 TB  f. 1024 PB       
g. 1024 XB  h. 1024 ZB

3. Formatting in Word 2013

A. 1. page formatting, 2. margin size, 3. Portrait  4. Page, 5. Line spacing, 6. Vertical 
alignment 

B. 1. d 2. b 3. d 4. a 5. d
--------------------C. 1. Page formatting refers  for page formatting. 2. You can also 

-------------------- ------------------- set depict the margins. 3. Word 2013 has a variety 
-------------------- document will be changed. 4. Select the text format into columns. 

------------------------ 5. Line spacing is the space or in units called points. 6. Vertical 
-------------------- alignment refers right page margins.

4. Virus and Antivirus

A. 1. T 2. F 3. T 4. T 5. T 6. F 7. T

B. 1.stealth 2.System Infectors 3.boot sector 4.malicious 5.Antivirus 6.periodically 
7.virus 

C. 1.b 2.d 3.c 4.d
-------------------- D. 1. A computer virus is a in order to be activated. 2. A virus can 

-------------------- -----------------only spread or a USB drive. 3. Virus have different 
--- file stored on the disk. 4. Three main types: File Virus, Boot Sector and Stealth 

-------------------- Virus. 5. Antivirus software is a keep it up to data. 6. Antivirus 

--------------
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software is used to prevent, detect and remove malware. 

5. Algorithms and Flowcharts

A. 1. T 2. F 3. T 4. T 5. F 6. F 

B. 1. program 2. Algorithm 3. flowchart 4. Flowchart 5. boxes, arrows 6. Input/Output

C. 1. a 2. c 3. c 4. d

D. 1. c 2. e 3. b 4. a 5. f 6. d
-------------------- E. 1. Algorithm is a set writing computer programs. 2. Graphical 

----------representation of a program is called Flowchart. 3. To draw flowcharts, we 
---------- in all four directions. 4. Do yourself 5. Do yourself 6. Step by step 
procedure to solve a problem is called Algorithm, while the graphical 

----------------representation of the same is called Flowchart. 7. Input/Output box is 
----------- shown in this box. 8. Processing box is used to indicate calculations done 
in a flowchart. 

6. Procedure in LOGO

A. 1. F 2. F 3. T 4. F 5. F 6. T 7. T 8. F 9. T 10. F 

B. 1. Immediate Mode, Procedure 2. procedure 3. commands 4. TITLE 5. BODY 
6. END 7. <F2> 8. Sub Procedure 9. Super Procedure 10. Procedure 11. procedure 
12. LOGO PRIMITIVE MAKE 13. PARAMETER 14. Recursion

C. 1. d 2. b 3. a 4. d
-------------------- D. 1. Procedure is not a socks and then shoes. 2. TITLE: name of 

the procedure is written, BODY: combined set of commands/primitives and END: 
last part of the procedure. 3. Sign like '>' appears. 4. F2 key 5. When a procedure is   
-------------------- ---------example of Super Procedure. 6. Advantages of procedure: 
----------- -------------------- possibility of errors, 7. Variable is such a variables in 
LOGO. 8. The value stored in Global Variable can be used by any procedure, while 
the value stored in Local Variable can be used only in the procedure in which it is 

------------------------- defined. 9. When a procedure calls repeated turns are over. 
10. Used to execute a LOGO command on conditional basis. 11. It is used to stop 
the procedure with a condition. 12. It is used to enter a sequence of characters as 
input. 

7. Features of MS-Word 2013

A. 1. T 2. F 3. T 4. T 5. T 6. F 

B. 1. wavy lines 2. document 3. Ignore all 4. Sentence case 5. Find 6. Ctrl + H 

C. 1. c 2. b 3. a 4. d 5. c

-------------------- D. 1. By default, Word automatically checks click Change to 
-------------------- correct the error. 2. The spelling and grammar check to change or 

------------------------- ignore it. 3. The Thesaurus tool provides in the list of results. 
-------------------- 4. Sometimes after typing drop-down menu. 5. A bullet is a dot or 

-------------------- a symbol again to end the list.

11



8. Starting MS-Excel 2013

A. 1. T 2. F 3. F 4. T 5. T 6. F

B. 1. workbooks 2. arrow 3. column 4. Formula 5. 255, 6. .xlsx

C. 1. c 2. a 3. b 4. d 5.a 
-------------------- D. 1. A workbook in Excel between the worksheets. 2. The text 

-------------------- --------you are typing and begin typing. 3. By default, a workbook 
------------ -------------------- workbook will appear. 4. The steps to save the 

-------------------- extension .xlsx. 5. On the Home tab Go To Special dialog box.

9. More in Power Point 2013

A. 1. animation 2. Slide Navigation pane 3. projectors 4. background  5. Apply to 
All  6. layouts.

B. 1. c 2. a 3. b 4. d 5. d 6. a
-------------------- C. 1. Organizing slides means way you want. 2. If you want to 

------------------------ create several the selected location. 3. A theme is a predefined 
-------------------- ---------------your existing placeholders. 4. Hover the mouse over 
----- -------------------- of a dotted line. 5. Text can be inserted and begin typing. 6. 

-------------------- Once you have arranged  exit presentation mode.

10. Introduction to Multimedia

A. 1. T 2. F 3. T 4. F 5. T 6. T 7. T

B. 1. Sound 2. presentation 3. Presentation 4. engineers, computer 5. browsers, 
colour 6. .swf, .mp4

C. 1. c 2. a 3. b 4. b
-------------------- D. 1. Multimedia can be almost animation and video. 2. The 

-------------------- software that is called presentation software. 3. Entertainment, 
Video Games, Media Player, Engineering, etc. 4. Video Games are softwares to 
play games while Media Player is used for viewing movies, listening to music and 
songs. 5. In science, it is mainly used for modeling and simulation. Experiment of 
Science can be explained with the help of multimedia presentations. 6. (a) Sound is 
recorded using a microphone, SmartSound, etc. and added to a multimedia 
presentation from a variety of sources while text is the most fundamental element of 
any multimedia project. (b)Videos are the moving images in a multimedia project, 
while Animation is a group of graphics images that contain movement. (c) Graphics 
are added in the form of photographs or designs, while Sound is recorded using 
microphone and then added to a multimedia project.

1. The Computer System
A. 1. voltage 2. five 3. touch 4. Mainframe 5. magnetically 6. pixels 7. LCD
B. 1. F, 2. T, 3. F, 4.T, 5. T 6. F 7. T 
C. 1. b 2. a 3. d 4. b 5. c 6. b 7. a 8. b 9. c 10. d

-------------------- D. 1. Analog Computer is a temperature, speed, etc. 2. A 
-------------------- digital computer operates machines and calculators. 3. A 

Think and Connect-6
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---------------- hybrid computer either type of computation. 4.  Microcomputer 
-------------------- is a type of computer personal computers or PCs. 5. MICR is a 

---------------character the character printed in such ink. 6. A plotter is a printer 
----- -------------------- positively charged toner. 7. A compiler is a program 
program errors to the user. 8. High level computer language use formats C, C++ 
and Java.

2. Network and Communications

A. 1. nodes, 2. security, 3. Resource, 4. software, 5. transmission, 6. interface 
cards, 7. star topology 8. multipurpose 

B. 1. T, 2. F, 3. F, 4. T, 5. F, 6. T, 7. T 8. T

C. 1. b 2. a 3. d 4. a 5. c 6. b 7. d 8. a 9. b 10. c
 -------------------- D. 1. Software can be loaded throughout the building. 2. The 

 --------------------disadvantages on the network increases. 3. A Network 
 --------------------Interface Card network adapter card. 4. LAN supplies 

 --------------------networking capability connectivity between devices. (and). A 
 --------------------Metropolitan Area Network private or public. 5. Bus topology 

 --------------------refers to in Local Area Networks (LAN).  6. A star topology is 
  -------------------- --------------------the gets inoperable. 7. Coaxial cable is the 

 --------------------networks, cable TV etc. 8. In ring topology, or anti-clockwise. 
 --------------------9. Bluetooth is another cost and portability. 10. This is 

 --------------------another of world together. 

3. Algorithms and Flowcharts

A. 1. problem 2. plan 3. algorithm 4. diagram 5. communication 6. data  

B. 1. T  2. F  3. T  4. F 5. T  6. T  

C. 1. a   2. b   3. c   4. d   5. a  6. b

D. 1. An oval represents a start or end point. 2. A rectangle represents a 
 --------------------process. 3. Flowcharts provide an in logic flow. 4. An 

 --------------------algorithm is a set number of steps. 5. A flowchart is a graphical 
 ---------------------- problems with a computer. 6. Flowcharts use special shapes 

 -------------------- tape are not in use nowadays.

4. More About Windows-2007

A. 1. hardware 2. icon 3. bottom 4. My Documents 5. Restore all items

B. 1. c 2. c 3. c

 --------------------C. 1. Operating System (OS) is a system carry out their 
---------------functions. 2. Windows operating systems, the Microsoft Desktop 

  ----- --------------------contents of the folder. 3. The taskbar is located at 
 --------------------unlabeled and unused. 4. An icon is a small pictograph used in 

 --------------------Recycle Bin and Network Places. 5. Deleting files in the 
Recycle Bin window. 
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5. Programming With LOGO

A. 1. procedure 2. blank spaces 3. END 4. “TO” 5. mass storage device 6. sub 
procedure.
B. 1. F 2. F 3. T 4. F 5. T 
C. 1. d 2. c 3. b

 --------------------D. 1. A LOGO procedure is a set of perform one main task. A 
procedure is divided into three parts: (i) Title Line (ii) Body (iii) End Line 2. 

 --------------------There are few rules which are Q 34, 3 Rectangle, X-Y, etc. 3. 
 --------------------The instruction which we have press the enter key. 4. In LOGO, 

 --------------------you can use a Box2 is the main procedure. 5. A procedure 
containing another procedure is called main procedure. It contains another 
procedure while sub procedure does not contain.  Main Procedure: 
TO BOX2
OS
REPEAT8[SQUARE RT 45]
END
Sub Procedure: TO SQUARE
REPEAT4[FD40 RT90]
HT
END

 --------------------6. In simple language, recursion means using a variable 
named STEP.

6. MS-Wrod 2013
A. 1. Page Layout, 2. Paragraph Group, 3. Indent, 4. Home Tab, 5. Dialog Box, 6. 
Quick Style List, 7. table   
B. 1. T 2. T 3. F 4. F 5. T 6. F 7. T  
C. 1. c 2. a 3. d 4. b 5. c 6. a 

 --------------------D. 1. The paragraph alignment allows you both the left and 
 --------------------right margins. 2. To make your page affective and impressive 

the appropriate options 3. A table is a grid of cells arranged in rows and 
columns. Tables are useful for various tasks such as presenting text 
information and numerical data. In Word, you can create a blank table, convert 
text to a table, and apply a variety of styles and formats to existing tables. 4. To 

 --------------------Insert a Blank Table: Place your insertion point table to add 
 --------------------text. 5. Special characters are punctuation, Choose the 

 --------------------appropriate symbol. 6. All graphics can be resized left or right 
centered anchor. 

7. Formatting Data in Excel 2013

A. 1. formatting 2. font 3. format 4. horizontal 5. Wrapping 6. Orientation
B. 1. T, 2. F, 3. T, 4. F, 5. T, 6. F 
C. 1. d 2. c 3. b 4. d 5. a 6. c 

 --------------------D. 1. First you will have to select change to the selected font. 
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 color --------------------2. Change Font Color: To change the color of text in cells 
from the drop down menu. --------------3. Add Borders to Cells : To add borders to 

 ------ -------------------the drop down menu.  4. Often a label applies to multiple 
Merge and center commands. 5. Orientation refers to the relative physical       

 -------------------- appear titled at this angle.  6. You can also use Excel 2013's 
 --------------------pre-designed cell    applied on the selected cells.  

8. QBASIC
A. 1. programming 2. Instruction 3. Dartmouth 4. Symbolic 5. BASIC 6. 
keywords 
B. 1. F 2. T  3. F   4. T  5. F 6. T  
C. 1. b  2. c  3. d  4. a  5. b  6. c 

   -------------------- -------D.  1. BASIC stands for May 1, 1964. 2. QBASIC stands for 
  ------------- --------------------learn and use. 3. LET is an assignment REM 

   ------------------<Remark>. 4. Relational operators are used 
 --------------------5. Logical operators are Logical Negation. 6. PRINT DATE$ : 

 --------------------The computer system If it is 8:30 pm.
9. Working in Flash

A. 1. Timeline 2. frame rate 3. human 4. animations 5. animate 6. Timeline 7. 
24.00 fps 8. keyframe 
B. 1. T 2. F 3. T 4. T 5. F 6. T 7. F 8. T
C. 1. c 2. c 3. d 4. d 

 --------------------D. 1. Animation is a series of showing the images in sequence. 
 --------------------2. Flash animation is used navigation buttons. 3. Although 

th -------------------- -----------humans have until the 19  century. In the beginning, 
 --------- realistic lighting and textures. 4. Five types– Erase Normal, Erase Fills, 

Erase Lines, Erase Selected Fills and Erase Inside. 5. Five types– Paint Normal, 
Paint Fills, Paint Behind, Paint Selection and Paint Inside. 6. Open a new flash 

 --------------------file your product into flash file. 7. Open a new flash file. Now 
you can see a single Layer called “ Layer 1” in your timeline. Select the first 
frame by clicking the rectangle under frame number1. Press F8 to convert this 

 --------------------image to a your product into flash file. 
10. Internet

A. 1. Transfer Protocol 2. 1969 3. tremendous 4. Internet, body 5. data, analog 
6. Communication 7. URL 8. website, programs 
B. 1. T 2. T 3. F 4. T 5. F 6. F 7. T 8. T 9. T 10. T
C. 1. a 2. b 3. c 4. a 

 -----------------------------D. 1. The Internet is a web connected to the Internet. 
 --------------------2. Internet is a very useful in many ways. 3. People browse 

-------------------- -----internet encyclopedia on Internet. 4. Modem is the short 
  --------------- --------------------to digital signal. 5. (a) A markup language using 

HTML. While TCP/IP (Transmission Control Protocol/Internet Protocol) is the 
basic communication language or protocol of the Internet. It can also be used 
as a communications protocol in a private network (either an intranet or 

<> Not equal to .
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extranet). When you are set up with direct access to the Internet, your 
computer is provided with a copy of the TCP/IP program just as every other 
computer that you may send message to or get information from also has a 

 --------------------copy of TCP/IP. (b) A web server is a program read a 
document. While A home page is generally the main page a visitor navigating 
to a website from a web search engine will see, and it may also serve as a 
landing page to attract visitors. The home page is used to facilitate navigation 
to other pages on the site by providing links to prioritized and recent articles 

 --------------------and pages, and possibly a search box. (c) FTP is a method cost 
 --------------------------and choice. While every web page or called http server. 

 ---------------------------6. EQUIPMENTS REQUIRED FOR USING INTERNET and 
-----------------provides access to www resources. 7. Web browser is a software 

 -------- ------------access to www resources. 8. While browsing internet, we surf 
 ------------- imagined in the past moving earth. 

1. Computer System

A. 1. components  2. Hardware  3. Software  4. electronically 5. acquired      
6. diskettes 7. numbers 
B. 1. F 2. F 3. T 4. T 5. T 6. T 
C. 1. a 2. b 3. c 4. d 5. a 6. b 7. c  

 ----------------------------D. 1. A computer system consists run in the computer. 
  --------------------2. Hardware refers to objects that could not be used. 

External hardware examples: Monitor and Keyboard & Internal hardware 
----------examples: Motherboard and RAM. 3. Software refers to the computer 

 ---------- an application service provider. 4. Some general kinds of application 
 --------------------------software include: Productivity software, which 

manufacturing environments). 5. Digital computer represents all kinds of 
 --------------------information  numbers from bottom to top (1111011) 6. The 2 

 --------------------Decimal Number System uses base = 16 + 0 + 4 + 2 + 1 = 23 7. 
 --------------------Hexadecimal Number System Consists of 16 = 48 + 10 = 58

2. More on MS-Word 2013

A. 1. portrait 2. Columns 3. text wrapping  4. text matter 5. Hyphenating 6. 
software 7. space 

B. 1. T  2. T  3. F  4. F   5. T  6. F  7. T  

C. 1. a  2. c  3. b   4. d  5. a  6. a 7. c
 --------------------D.  1. Page layout tab describes to design our pages. 2. This 

 --------------------menu gives our page in landscape view. 3. This option helps us 
 -------------------- --to choose with square text wrapping 4. It helps us to choose 

 ------------------ set as default layout. 5. Spacing : This option helps us to arrange 
 -------------------- -------below the selected paragraph 6. When word moves out 

 ------------- to hyphenate your text matter. 7. When we are typing a document, 

Think and Connect-7
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 --------------------Word on the next odd-numbered page.
3. Advance MS-Word 2013

A. 1. object 2. selection 3. visible 4. Align 5. Group 6. Rotate 7. vertically
B. 1. F  2. F   3. T  4. T   5. F  6. T  7. T 
C. 1. b  2. c   3. d   4. a  5. c  6. d  7. b
D. 1. The three sub options are: Bring forward, Bring to front, Bring in front of 
the text 2. The three sub options are: Send backward, Send to back, Send 

 --------------------behind text 3. In selection plane we can changing their 
 --------------------visibility. 4. If we click on selection plane, a table objects in the 

 --------------------document will be hidden. 5. This option allows us to change 
 --------------------relative to one another. 6. This option allows joining as 

 --------------------individual object. 7. Align left : This option aligns the 
customization of the grids.

4. More on MS-Excel 2013
A. 1. columns 2. rows 3. Page Break 4. Background 5. Print 6. internet 7. Font   
B. 1. F  2. F  3. F  4. F  5. T  6. T  7. T 
C. 1. a  2. c   3. b   4. d  5. c  6. a  7. d 
D. 1. The two options are: Portrait and Landscape. 2. There are two types of 

----------page breaks:–Vertical and Horizontal. 3. This option allows us to insert 
  ---------- --------------------Bing image search. 4. This option allows us to search 

 --------------------inserted in the background. 5. This option allows us 
 --------------------customization of colors. 6. This tab provides us Background, 

 --------------------Print, Titles, etc. 7. This option allows us to choose the rows 
printed at the top of every page. 

5. Advanced MS-Excel 2013
A. 1. Page Setup  2. content 3. dimensions 4. Print 5. printing 6. gridlines 7. 
objects 
B. 1. F 2. F 3. F 4. F  5. T  6. F 7. T 
C. 1. d  2. a  3. b  4. c  5.d  6. b 7. c
D. 1. We can set titles to appear at the top for rows and at the left for columns. 

 --------------------2. It brings the selected object non-selected object will be 
hidden. 3. This option brings the selected object back one level so that it's 
hidden behind more objects. Select the object and click on the send backward 
option. The object will be send back one level. 4. MS-Excel 2013 provides 
various sheet options for printing purpose. Generally cell gridlines are not 
printed. If we want our printout to include the gridlines, Choose Page Layout  
tab     Sheet Options group      Gridlines     Check Print. 5. We should click on 
Print Preview before we click on Print, so that we can see what exactly your 
document will look like before we actually print it. 6. This option sends back     

 -------------------- back to all other objects. 7. Due to the nature of 
spreadsheets, it can be tricky getting those last few rows and columns onto the 
same page as the rest of your spreadsheet. MS Excel 2013 has just a feature to 

 --------------------answer our problems. Now, we are going to study look after 
print command.
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6. HTML
A. 1. tags, elements  2. SGML (Standard Generalized Markup Language) 
3. Container, Empty 4. slash (/) 5. <P align=center> 6. <BR> 7. Ordered 
Lists 8. indented definition 
B. 1. F 2. F 3. F 4. F 5. F 6. F 7. T 8. T
C. 1. a 2. a 3. a 4. c 5. c 

 --------------------D. 1. The term HTML stands for for creating web documents. 
 --------------------2. (a) Container tag has a starting as well as ending tag while 

--------Empty tag does not have an ending tag. (b) The <P> tag tells the browser 
  ------------ -------------------displayed on the next line and the <BR> tag is used to 

 --------------------key on your keyboard. (c) The <HEAD> tag is used to denote 
properties of the entire page while the <TITLE> or <title> tag is used to give a    

 -------------------- contents of the page. 3. Netscape Navigator, Internet 
Explorer, Mozilla Firefox, Safari, Opera, Google Chrome, etc. 4. In an ordered 
list each item is automatically numbered starting with 1 while in menu list 

 --------------------each element is a word than the other lists.  5. (a) Text control 
 --------------------tag(Container tag) : Container tag has a starting </tag> (b) 

 --------------------Generally, the web browser ignores the text to be displayed. 
 --------------------(c) A list within another list is called Nested names or some 

 --------------------bills. (d) The <Head> tag of the entire page.  

7. Photoshop CS5
A. 1. raster graphics 2. hungry 3. 2D 4. pixels 5. lines, geometric 6. duplicate 7. 
Brush 8. blemishes, imperfections 
B. 1. F 2. T 3. F 4. T 5. T 6. T 7. T  
C. 1. a 2. a 3. c 4. a 5. c 6. b

 --------------------D. 1. Photoshop CS5 is an application which known as 'Raster 
 --------------------graphics'. 2. Bitmap images are made up of what you see on 

 --------------------your screen while vector images are made up of many at the 
highest quality. 3. The Brush tool paints brush strokes and Pencil tool paints 

 --------------------hard-edged strokes. 4. (a) the Healing Brush tool paints with a  
-------------blemishes, etc. in a image while the Patch tool repairs imperfection 

 ------- --------using a sample or pattern. (b) The History Brush tool paints a copy 
 ------------ the current image window while the Art History Brush tool paints 

 --------------------with stylized selected state or snapshot. (c) The Eraser tool 
 --------------------erases pixel and previously saved state while the Magic Eraser 

 --------------------tool provides you with a color area very easily. (d) The Blur 
tool blurs hard edges in an image while the Smudge tool smudge data in an 
image. (e) The Dodge tool lighten areas in an image while the Sponge tool 
changes the color saturation of an area. 5. The Pen tool allows you to draw 

-----------smooth-edged paths. 6. Layers are like transparencies stacked on top 
 --------- contain one or more layers. 7. Masking is the protection of the image. 

 --------------------Masks allow you to isolated  effects to an image. 8. There are 
 --------------------three types shape of another layer.
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8. Internet
A. 1. Internet 2. between, connection 3. Electronic Mail 4. web browser 5. Dial-
up Access, Dedicated or Leased Lines 6. Transmission Control Protocol/ 
Internet Protocol 7. Internet 8. network 9. Uniform Resource Locator 10. 
HyperText Transfer Protocol 
B. 1. T 2. F 3. F 4. T 5. F 6. F 7. F 8. T
C. 1. c 2. c 3. d 4. d 5. b

 --------------------D. 1. A system of global collection house throughout the 
world. 2. to communicate with the other computers, to receive messages or 
retrieve information, to exchange information, etc. 3. The World Wide Web 

 --------------------(WWW) is the server are known as Web Pages. 4. The domain 
 --------------------name refers to the name of the computer organizations that 

 --------------------own the site. URL is the location identifier for www.msn.com 
 -------------------and so on. 5. To get connected with the internet, the hardware 

 --------------------A modem. To start using Internet, the software and Mosaic 
 --------------------are needed. 6. The United States Department of Defense 

--------mainly used for commercial purpose. 7. Email stands for Electronic Mail 
 ------------ -to other users through internet. 8. The acronym TCP/IP stands for    

 ------------------- each other using TCP/IP. 9. HTTP or HyperText Transfer 
 -----------------------Protocol is the protocol communication with each other. 

 --------------------10. Communication on the internet material stored around 
 --------------------the world. 11. There are two main ways to the money one can 

afford.
9. Adobe Flash CS5

A. 1. May, 1996 2. Frame-by-frame 3. Frames, Play head 4. Movie Clip, Graphic 
5. 0.01, 120  6. 550, 400  7. Flash  
B. 1. T 2. T 3. F 4. T 5. F 6. T 7. F 8. T
C. 1. b 2. c 3. c 4. d 5. c 

 --------------------D. 1. Multimedia is simply multiple forms animation, video, 
 --------------------data, etc. 2. Flash began life in May 1996 to Macromedia Flash 

 --------------------1.0. 3. Animation means creating timed core functions of 
 --------------------Flash. 4. Interface is the area where computer or programs. It 

includes– Menu bar, Play Head, Timeline Header, Timeline Status, Layers, 
 --------------------Frames, etc. 5. In flash, the objects tools of drawing toolbar. 

These are included as Drawing Toolbar, Oval Tool, Rectangle Tool, PolyStar 
Tool, Line Tool, etc. 6. There are three types of symbols in Adobe Flash CS5. 

 --------------------Movie Clip Symbols are to use it in your project. 7. Layers are 
 --------------------similar to transparent sheets Mask and Masked. 

 --------------------E. 1. Multimedia is simply multiple forms being played in a 
 --------------------hall. 2. Adobe Flash Professional CS5 is an authoring tool user 

  --------------------interface application, etc. 3. The Timeline controls the timing 
 --------------------proceeds through the frames. 4. Panel is used to change 

----------colour, and stroke size. 5. Layers are similar to transparent sheets that 
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---------- ------------the layers are placed. 6. Symbols are the main component in 
-------- -------------------- gets stored in 'library'. 7. You can also draw a path with 
it around the required path.

10. QBASIC
A. 1. BASIC 2. Constants 3. alphanumeric 4. numeric 5. circle 6. PLAY 7. color
B. 1. T  2. T  3. F  4. T  5. T  6. T  7. T 
C. 1. a  2. b  3. c  4. d  5. a  6. b 7. c

--------------- D. 1. PASCAL, C, C++ and JAVA. 2. Constants are the data execution 
---------------- of program. 3. There are two types of constants: String example: 
------------------ 5,-7,7426.42, etc. 4. A variable is a symbolic unique Double 

-----------------precision- hashtag (#). 5. The SOUND command produces sound 
---------  f - Frequency in Hertz

d - Duration in ticks
-------------------- 6. Select-Case statements also work like printed for values 

-------------------- less than 10. 7. Looping is used to have the computer block (if 
it's END command, the program just ends).

1. Introduction to Visual Basic

A. 1. Command Button 2. initial, position, relative size 3. DOS, BASIC 4. IDE 
(Integrated Development Environment) 5. Label 6. Textbox 7. New Project 8. 
statements 
B. 1. T 2. T 3. T 4. F 5. T 6. T 7. F 8. F  
C. 1. c 2. b 3. d 4. c
D. 1. Visual Basic is a high level programming language evolved from the earlier 
DOS version called BASIC. 2. In object oriented programming, the programmer 
need to be an expert windows programmer to create functional windows 
programs while in event-driven programming, the programmer doesn't need to 
be an expert windows programmer. 3. Based on event-driven model, IDE, 
Toolbox, Form Layout Window, Project Window, Object Browser, Form Window, 

 -----------------Compilation Options, etc. 4. Visual Basic's Integrated additional 
programs. 5. Windows, Menu bar, Tool bar, etc. 6. Standard EXE allows the 
programmer to create a standard executable program. 7. (a) Check Box: 
Provides the user with a toggle choice. (b) Option Button: Used for selection as 
group. (c) List Box: Allow user to add and delete items from the list. (d) Pointer: 
Used to select tools already on the form. (e) Shape: Control for drawing circles, 
rectangles, etc. (f) Image: Control for displaying images. 8. Toolbar contains the 
icon to execute the command without using the menu bar option. 9. The 

 --------------------Microsoft windows uncovered by another window). 10. The 
 --------------------Properties window selected controls. 

2. Adobe Dreamweaver CS5
A. 1. Code view, Design view, Split view 2. Rectangle Hotspot, Polygon Hotspot                    
3. Cascading Style Sheet 4. Webpage 5. Document 6. Image map 7. Library 8. 

Think and Connect-8
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Library  
B. 1. T 2. F 3. F 4. T 5. T 6. T 7. T 8. T 
C. 1. b 2. c 3. d 4. a 5. d 6. b

 --------------------D. 1. Adobe Dreamweaver is a professional as a visual editing 
 --------------------environment. 2. Adobe Dreamweaver is a program that 
 --------------------ActionScript, and JavaScript. 3. Features of Dreamweaver 

----------Web Standard Support. 4. Code view: A hand-coding environment for 
 ---------- ---------------from the Document toolbar. 5. Select a paragraph format 

  ----- -------------------will be restored to default. 6. Forms are used in web pages 
 -------------------Dreamweaver using the form objects. 7. CSS is used to format 
 -------------------once in a CSS document. 8. Text: A text filled element is used 

-----must contain different field values. 9. Library is a list of page elements that 
 --------------- site option in the Assets panel.

3. Networking Concept

A. 1. hardware 2. Viruses 3. hardware 4. Network 5. Computer 6. NOS 7. 
Modem. 
B. 1. T 2. T 3. F 4. F 5. T 6. F 7. T 
C. 1. b 2. d 3. c 4. a 

 -----------------------------D. 1. Computer networking is all or wired technology. 
 ------------------------2. Advantages : Files can be stored from any workstation. 

3. Server, Workstations, Network Interface Card, Network Operating System,  
and Networking Channel 4. satellites, radio wave, microwaves, etc. 5. Twisted 

 -------------------pair, Co-axial cable and optics. 6. The word modem is actually a 
DSL (Digital Subscriber Line) modems. 7. Network topology is the way a 

 -------------------network is large length of cable is required. 

4. Advanced HTML

A. 1. language 2. an inline image 3. image 4. Links 5. row 6. BORDER 7. Forms   
8. submit 9. MAXLENGHT 10. <SELECT>

B. 1. T 2. F 3. T 4. F 5. T 6. T 7. F 8. F 9. T 10. F 

C. 1. a 2. a 3. b 4. d 5. d
 -------------------D. 1. HTML (HyperText Markup Language) is the set of Wide 

 -------------------Web browser page. HTML is a formal recommendation by tags 
--------------to describe web pages. 2. Inline Images : These types of images are 

 ----- complete its downloading process. External Images : These images 
 -------------------neither are of the image gets initiated. 3. Border, Space 

 ---------------------Attribute, Alt 4. The major concept of linking Times of </A>. 
5. Border, Cell Spacing, Cell Padding, Column spanning and Row Spanning       

 -------------------6. HTML has number of tags to create and labels on those 
 -------------------controls. 7. You can give the directions = 5alt = "text">.

5. Advanced Adobe Flash CS5

A. 1. Macromedia 2. Shock Wave Flash 3. display, outlines 4. layers 5. graphics 
6. Masking 7. Flash 
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B. 1. F 2. F 3. T 4. T 5. T 6. T 7. T 8. F
C. 1. b 2. b 3. d 4. d 5. d
D. 1. Flash is a popular authoring software developed by Macromedia. 2. Flash 

 -------------------is used to create graphic-based modem connection. 3. Click 
the Add layer button at the bottom of the Timeline. And then choose 

 -------------------Insert>Layer. 4. Masking is easy computer graphics. 5. Prepare 
  ------------------- -------------------the image Export Movie. 6. To import a sound: 

current movie.
6. MS-Word 2013

A. 1. chapters 2. manually 3. automatically 4. links 5. superscripted 6. caption  
7. hyperlink 
B. 1. F 2. T 3. T 4. T 5. F 6. T 7. T 
C. 1. a  2. b  3. c 4. d  5. a  6. b 7. c  

 -------------------D. 1. Table of contents is just section begins. 2. To apply a 
 -------------------heading style, group on the Home tab. 3. The first step to 

 -------------------create a reference citations and references. 4. Microsoft word 
 -------------------2013 has a feature reference in our document. 5. It refers to 
 -------------------specific places in our thing you are referencing. 6. A caption is a 

 -------------------numbered label, such as click Update Field on the shortcut 
 -------------------menu. 7. The difference between a footnote and an endnote 

and choosing the command convert to footnote. 
7. Moving Ahead in MS-Word 2013

A. 1. envelope 2. Avery 3. margin 4. Address 5. spelling 6. Thesaurus 7. Review 
B. 1. F 2. F 3. T 4. T 5. T 6. F 7. T 
C. 1. d  2. c 3. b  4. a  5. b 6. a 7. c
D. 1. Shift+F7 2. Thesaurus gives synonyms and antonyms of selected word in 
a document. 3. Print layout shows how our document will look, when it's 
printed while Web layout shows how our document will look as a webpage. 

 -------------------4. Label: It is best way to save time starting with a template. 
 ---------------------5. Mail Merge is a useful tool typically an Excel workbook. 

 -------------------6. When we turn on Track Changes, every change Changes 
command. Track Changes will be turned on. 7. To check spelling and 

 -------------------grammar go to the Review wrong words will be replaced.
8. MS-Excel 2013

A. 1. function  2. cell range  3. FORMULAS  4. external  5. database  6. location 
7. worksheet
B. 1. F 2. F 3. F 4. T 5. F 6. T 7. T 
C. 1. a 2. b 3. c 4. d 5. a 6. b 7. c 
D. 1. To access the Function Library, select the Formulas tab on the Ribbon.   
2. Filters are cumulative, which means we can apply multiple filters to help 

 -------------------narrow down the results. 3. MS-Excel 2013 supports pulling  
---------columns and rows we want. 4. External data exists outside of the Excel 

 ---------- with the External Data feature 5. Filters are cumulative, which means 
we can apply multiple filters to help narrow down the results. Click the drop-
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down arrow for the column you want to filter. The Filter menu will appear. 
Check or uncheck the boxes depending on the data you want to filter and then 
click OK. The new filter will be applied.

 -------------------6. Filters names: Click the filter see the below table. 

9. Moving Further in MS-Excel 2013
A. 1. columns 2. value  3. invalid 4. workbook 5. encrypts 6. cells 7. VIEW
B. 1. F 2. T 3. F 4. T 5. T 6. T 7. F 
C. 1. c 2. d 3. a 4. b 5. c 6. d 7. a
D. 1. This view can help us visualize how our worksheet will appear when 

 -------------------printed. 2. This view makes it easy printing a lot of data from 
 -------------------Excel. 3. MS-Excel 2013 has a variety of viewing Ribbon under 

 -------------------the View tab. 4. MS-Excel 2013 gives us several ways to click 
OK. Your workbook will be protected. 5. To protect from incorrect data entry, 

 -------------------we can use data validation to restrict Title, and Input message: 
 -------------------5. Click OK. 6. Each cell in the worksheet can be locked or box 

and then click OK or press Enter. 7. If we are not using macros, we are ignoring 
 -------------------one of Excel's matter and always begin at the A1 position.

10. Introduction to MS-Access 2013
A. 1. input 2. database 3. data 4. sharing  5. transaction 6. tables 7. query
B. 1. T 2. T 3. T 4. F 5. F 6. T 7. T 
C. 1. c 2. b 3. a 4. d 5. a 6. d 7. b

 -------------------D. 1. A database is simply be easily accessed. 2. Database 
 -------------------management involves database management system (DBMS).

3. (i) Data Storage Management (ii) Data Manipulation Management (iii) Data 
Definition Services (iv) Data Dictionary/System Catalogue Management (v) 
Database Communication Interfaces (vi) Authorization / Security 
Management (vii) Backup and Recovery Management (viii) Concurrency 
Control Service (ix) Transaction Management (x) Database Access and 
Application Programming Interfaces

 -------------------4. Forms : Forms are used for entering, modifying one or more 
 ---------------related tables. While Queries : Queries provide a way of searching 

Option

Names Scoped to 
Worksheet

Names Scoped to 
Workbook

Names with Errors

Names without Errors
Defined Names
Table Names

Result
Displays names local to a worksheet

Displays names global to a workbook

Displays names with values that contain 
errors (such as NAME, VALUE, etc.)

Displays names without errors
Displays names defined by you or by Excel
Displays table names
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-------------might carry out within a table. 5. A primary key is one or more fields 
 ------------- unique for each table record. 6. Specify a primary key: 1. In Design 

 --------------------view, create a field that primary key will be removed. 7. When 
 -------------------we sort records, we put  lowest ID numbers appear first. 

11. Surfing Internet
A. 1. Internet 2. Documents 3. Web Pages 4. HTML 5. Multimedia 6. Language, 
web 7. Web Pages 8. classify, tools 9. computer 
B. 1. T 2. T 3. F 4. T 5. T 6. F 7. T 8. T 9. F  
C. 1. b 2. b 3. b 4. b

 -------------------D. 1. Internet is a necessity for International Network. When 
 -------------------millions of networks are called web pages. 2. The WWW is a 

 -------------------network web pages are called web browsers. 3. HTML is a 
language which is mainly used to create web documents. HTML allows the 

 -------------------creation of hyperlinks control over text formatting. 4. HTML 
 -------------------can be used to display any document hyperlinks to other 

 -------------------documents. 5. Multimedia is a term that was to apply CD-ROM 
 -------------------applications. 6. RTC is any mode the source and the 

destination. 7. Photoshop, Director, Premiere, Sound Edit, Flash, Front-page, 
 -------------------Alias/Wave front. 8. Go to http://www.blogger.com. profile 

and begin posting.
12. Introduction to Java

A. 1. applications 2. objects 3. Inheritance 4. encapsulation 5. encapsulated 6. 
DOS 7. Operators
B. 1. T 2. T 3. F 4. T 5. T 6. F 7. T 
C. 1. a 2. b 3. c 4. d 5. a 6. b 7. c
D. 1. Java is a programming language and computing platform. Java was first 
released by Sun Microsystems in 1995. 2. (i). Arithmetic Operators (ii) 
Increment and decrement Operators (iii) Relational Operators, and (iv) Logical 

 -------------------Operators 3. Relational operator compares Java are: ==, !=, <, 
 ------------------->, <=, and>=. 4. Arithmetic Operators Java and % (modulo). 

 -------------------While A logical operator is some times one or two other 
 -------------------expressions. 5. We enter the Java program into the computer 

java in the File name box. 5. Then, click on the Save button. 6. We compile Java 
 -------------------program at with extension> to compile the program. The 

--------------program will be compiled. 7. Object Oriented Programming (OOP) 
 ---------- Encapsulation and Data abstraction.   


